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Propósito 
 
A partir del correcto uso de las herramientas de observación y análisis de la astronomía 
moderna, tales como las simuladas en el Observatorio Virtual Educacional VIREO, tú 
deberías ser capaz de ver cómo son los diagramas HR de los cúmulos estelares, y luego 
poder determinar la edad y distancia de sus estrellas. 
 
Objetivos 
 

Si tú aprendes cómo hacer para … 
 
presentar los diagramas HR de diferentes cúmulos estelares; 
 
ajustar las curvas teóricas de “secuencias principales de edad cero” a los valores 
reales del cúmulo para así poder determinar su distancia y la cantidad del 
enrojecimiento interestelar debido a la absorción por el polvo; 
 
ajustar las curvas teóricas isocrónicas con la del cúmulo para determinar su edad. 

 
Entonces tú deberías poder … 
 
comparar la distancia a un cúmulo con las de otros; 
 
comparar la edad de un cúmulo con las de otros. 

 
 
 
 
TÉRMINOS IMPORTANTES QUE TÚ DEBERÍAS REVISAR EN TU TEXTO Y 

EN ESTA GUIA PARA ESTUDIANTES: 
Magnitud 
absoluta 

 

Magnitud 
aparente 

Indice de color 
B-V 

Declinación Módulo de 
distancia 

Cúmulo 
globular 

Diagrama HR Isócrona Luminosidad Secuencia 
principal 

Vía Láctea Cúmulo 
abierto 

Pársec Fotómetro Gigante roja Ascensión 
recta 

Tipo espectral Evolución 
estelar 

Masa estelar Enana blanca Secuencia 
principal de 
edad cero 
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INTRODUCCION 
Diagramas HR y sus múltiples aplicaciones 

 
 

Una de las herramientas más potentes con que cuenta la astronomía para estudiar 
la evolución y la edad de las estrellas es el diagrama Hertzsprung-Rusell, o más 
sencillamente, diagrama HR (Figura 1), al que también comúnmente se le llama diagrama 
Color-Magnitud. Se trata básicamente de un gráfico que muestra la temperatura 
superficial versus la luminosidad para un determinado grupo de estrellas. Un ejemplo de 
diagrama HR se muestra en la figura de más abajo. Obsérvese que las estrellas con 
temperaturas más bajas aparecen en el lado derecho del diagrama HR, de forma tal que la 
temperatura aumenta hacia la izquierda. 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figura 1: El diagrama HR 

 
La luminosidad de una estrella (o su magnitud absoluta) y su temperatura (o su 

tipo espectral, o su índice de color B-V) determinan su posición en el diagrama HR. 
Como se puede ver en el diagrama adjunto, las estrellas más calientes y más luminosas 
son las que figuran a la izquierda y arriba, mientras que las estrellas más frías y más 
ténues son las que figuran a la derecha y abajo. Las estrellas de más arriba a la derecha 
son excepcionalmente luminosas a pesar de que tienen temperaturas superficiales bajas, 
por lo que necesariamente deben tener enormes áreas – sus radios pueden ser mil veces 
más grandes que el del Sol. Tales estrellas son llamadas gigantes rojas. Las estrellas de 
más abajo a la izquierda del diagrama son excepcionalmente débiles incluso a pesar de 
ser muy calientes, por lo que deben ser pequeñas – sus radios típicamente son cien veces 
menores que el radio del Sol, por lo que aproximadamente son del tamaño de la Tierra. 
Tales estrellas son llamadas enanas blancas. La mayoría de las estrellas se encuentran en 
el diagrama HR a lo largo de la línea que corre desde arriba a la izquierda hasta abajo a la 
derecha, una región que se conoce con el nombre de secuencia principal. 
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Las estrellas que se encuentran en la secuencia principal son las más comunes, 
dado que allí es donde las estrellas permanecen durante la mayor parte de su vida. Todas 
las estrellas en la secuencia principal comparten una misma característica: están 
produciendo energía a través de la fusión del hidrógeno en helio, lo que tiene lugar en 
una región específica – el centro de cada estrella, llamado el núcleo. La ubicación 
particular de una estrella en la secuencia principal depende de su masa (Figura 2). Las 
estrellas de masa pequeña (desde aproximadamente la masa de nuestro Sol para abajo, 
esto es, hasta aproximadamente 0,08 veces la masa del Sol) son las estrellas más frías y 
por tanto se ubican abajo a la derecha; las estrellas de gran masa (desde 2 veces la masa 
solar para arriba, esto es, hasta aproximadamente 50 veces la masa del Sol) son las 
estrellas más calientes, y por tanto se ubican arriba a la izquierda. Nuestro Sol es una 
estrella de la secuencia principal, con una temperatura superficial de 5.800 K (tipo 
espectral G2 V, índice espectral B-V = 0.66) y por tanto se ubica en la zona media de la 
secuencia principal, pero un poco corrido por debajo (hacia la derecha) de la mitad. 

 
 

Figura 2: La masa de las estrellas en el diagrama HR 
 

Los astrónomos creen que los cúmulos estelares son grupos de estrellas que 
nacieron juntas aproximadamente al mismo tiempo, a partir de una misma nube de gas 
interestelar. Los diagramas HR resultan particularmente útiles para estudiar las 
características de tales cúmulos. Las estrellas que pertenecen a un cúmulo tienen un rango 
de masas estelares que va desde muy masivas hasta de muy baja masa, por lo que cuando 
el cúmulo es extremadamente joven – cuando las estrellas apenas han comenzado a 
fusionar hidrógeno en sus núcleos – todas sus estrellas aparecerán a lo largo de la 
secuencia principal, rotulada en la Figura 2 como la secuencia principal de edad cero 
(“zero age main sequence”). Un cúmulo estelar muy conocido, las Pléyades (M45), se 
muestra en la Figura 3. 
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A medida que una estrella envejece va consumiendo el hidrógeno en su núcleo, 

hasta que habiéndolo agotado empieza a fusionar hidrógeno en una capa expansiva 
alrededor del núcleo (como si se tratase de un incendio que comienza en el medio de un 
bosque, y se va expandiendo hacia fuera). La estrella que va envejeciendo se expande y 
enfría, transformándose en una gigante roja. En un cúmulo, las primeras estrellas es 
convertirse en gigantes rojas son las de mayor masa, seguidas luego por otras no tan 
masivas, y así sucesivamente. Por tanto, a medida que el cúmulo envejece, su 
correspondiente secuencia principal se vuelve más corta (como un fusible que se va 
quemando), y la región del diagrama HR correspondiente a las gigantes rojas se vuelve 
más populosa. Esta cronología de eventos se ilustra en los diagramas HR de la Figura 4, y 
claramente se ve que el largo de la secuencia principal del cúmulo estelar se corresponde 
con su edad. En realidad, los astrónomos pueden elaborar modelos computacionales 
bastante precisos que muestran cómo la forma del diagrama HR de un cúmulo varía con 
su edad, lo que a su vez les permite determinar la edad de las estrellas en dicho cúmulo 
mediante la simple comparación del modelo computacional con su verdadero diagrama 
HR obtenido de la observación. En general esto no puede ser aplicado a estrellas aisladas 
que no pertenezcan a algún cúmulo – no sabemos si la estrella nació la semana pasada o 
hace algunos miles de millones de años atrás. Por lo tanto, los cúmulos estelares son 
indicadores sutiles de la evolución estelar, y resultan objetos de estudio muy preciados 
para los astrónomos que investigan la vida de las estrellas. 

 
Figura 4: Cómo el diagrama HR de un cúmulo va variando a medida que envejece 

  

Edad: 100 millones de años Edad: 800 millones de años 

 
Figura 3: Las Pléyades, ejemplo de cúmulo estelar abierto 
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Edad: 5 mil millones de años Edad: 10 mil millones de años 
 

También resulta posible el análisis de un diagrama HR de un cúmulo estelar para 
determinar la distancia a que se encuentra. Todas las estrellas de un cúmulo se hallan 
básicamente a la misma distancia desde nosotros, de manera tal que cuando miramos uno, 
la atenuación del brillo por efecto de la distancia es igual para todas sus estrellas. 
Podemos entonces graficar la magnitud aparente (m, algunas veces llamada V si es que 
ha sido medida a través de un filtro “V” estándar) de las estrellas del cúmulo versus el 
color (o temperatura o tipo espectral), y así obtener la secuencia principal aparente que 
resulta en tal diagrama HR. Esta secuencia principal aparente puede ser comparada con la 
secuencia principal de edad cero (la obtenida cuando se utiliza la magnitud absoluta, M, 
que representa la magnitud que tendría una determinada estrella si estuviese a una 
distancia estándar de 10 parsecs). La diferencia entre las magnitudes aparentes (m) de la 
secuencia principal y las magnitudes absolutas (M) de la secuencia principal de edad cero 
para un determinado cúmulo se llama su módulo de distancia, m – M. Por tanto, el 
módulo de distancia puede ser utilizado para determinar la distancia al cúmulo (medida 
en parsecs) usando la fórmula siguiente 

 
Log D = ((m-M)/5) +1 
 
  

 
 
 
 
 
 
 
 
 
 
 
 

Figura 5: El módulo de distancia (m–M) de un cluster es la diferencia entre la magnitud 
aparente (m) de sus estrellas de la secuencia principal y la magnitud absoluta (M) de las 
correspondientes estrellas de la secuencia principal de edad cero (o sea, de la ZAMS). 
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ANALISIS DE DIAGRAMAS HR DE CUMULOS 
ESTELARES USANDO EL OBSERVATORIO 

VIRTUAL EDUCACIONAL “VIREO” 
 
Inicio del programa 
 

El programa VIREO es un software estándar que corre bajo Microsoft Windows. 
Para aplicarlo, cliquea dos veces sobre el ícono VIREO de color naranja que aparece en 
tu escritorio. Selecciona File>Login desde la barra del menú, y a continuación ingresa tu 
nombre. Si cliqueas “OK”, verás que aparece la pantalla introductoria del Observatorio 
Virtual Educacional, por lo que ahora desde la barra del menú podrás seleccionar un 
determinado ejercicio. Cada posible ejercicio tiene sus propias particularidades, por lo 
que una vez que has elegido un determinado ejercicio accederás a muy distintas opciones. 

 
Acceso a los archivos de ayuda 

Tú mismo podrás encontrar instrucciones generales acerca de cómo usar el 
programa VIREO y sus distintas posibilidades al seleccionar la opción Help en la barra 
del menú. Dicho menú de ayuda está organizado por tema, y puede ser accedido 
simplemente cliqueando sobre el tema deseado. De la misma manera, también es posible 
acceder tanto a los sitios de red del Proyecto CLEA, como a otros sitios de interés para 
los usuarios de cualquiera de sus programas. 
 
Presentación de los valores de cúmulos estelares en un diagrama HR 

 
El programa VIREO contiene información fotométrica, tanto en magnitud V 

como en color B-V, para un gran número de estrellas pertenecientes a determinados 
cúmulos abiertos de la Vía Láctea. Dicha información, para cada cúmulo, puede ser 
accedida a través de VIREO y presentada en la correspondiente pantalla del computador. 
Además, VIREO contiene una gran base de datos acerca de los diagramas HR teóricos 
previstos para cúmulos estelares de diferentes edades y diferentes metalicidades. Para 
acceder a dicha información, te será de ayuda los siguientes pasos: 
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Figura 6: Seleccionando el ejercicio de Diagramas HR de cúmulos estelares 
 en la pantalla de inicio del programa VIREO 

 
• Abre el programa VIREO y loguéate. Una vez que la pantalla de apertura aparece, 

selecciona Run Exercise de la barra del menú, y a continuación H-R Diagrams of 
Star Clusters, como se muestra en la Figura 6. 

 
• El correspondiente título de pantalla debería mostrarse durante unos 5 segundos, para 

luego automáticamente desaparecer y ser reemplazado por el panel de control del 
Observatorio Virtual Educacional. Desde la barra superior del menú del panel de 
control elige: Tools > HR Diagram Analysis, dando paso así a la apertura de una 
ventana denominada Color-Magnitude Diagram (ver Figura 7).  

 
 

 
                                       Figura 7                                         Figura 8 

 
• Cliquea en el botón File de la barra del menú, y elige Load/Plot > Select Cluster 

Data. Aparecerá una lista mostrando todos los cúmulos para los cuales se dispone de 
información almacenada de sus magnitudes visuales e índices de color (B-V). 
Cliqueando dos veces el botón izquierdo del mouse sobre esta lista puedes seleccionar 
con qué cúmulo has de trabajar. La información correspondiente a cada estrella del 
cúmulo elegido aparecerá graficada en el diagrama color-magnitud de la ventana (el 
índice de color B-V en el eje x de las abscisas , y la magnitud V en el eje y de las 
ordenadas). Por ejemplo, si optas por el cúmulo M45 (Pléyades), el gráfico que 
aparecería será el de la Figura 8. 

 
Determinación de la distancia a un cúmulo mediante el ajuste de una secuencia 
principal de edad cero a su diagrama HR 
 
• Los astrónomos han determinado muy bien los valores de magnitudes absolutas e 

índices de color  que corresponden a estrellas normales de la secuencia principal, 
tanto a través de observaciones directas como de modelos teóricos. Para el caso de un 
diagrama HR de un cúmulo estelar, la secuencia principal forma lo que se conoce 
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como “secuencia principal de edad cero” (abreviado como ZAMS, según su 
correspondiente sigla en inglés). Puedes obtener dicha ZAMS yendo a la barra del 
menú de la ventana Color-Magnitude y eligiendo Tools > Zero-Age Main Sequence. 
Deberías ver entonces que aparece una curva verde en el gráfico, básicamente 
paralela a la secuencia principal del cúmulo, como se muestra en la Figura 9. 

 
 

 
Figura 9 

 
•  Sin embargo, los valores reales de la secuencia principal del cúmulo difieren de la 

curva estándar que representa la ZAMS debido a dos factores: (1) las estrellas del 
cúmulo podrían aparecen más brillantes o más ténues por hallarse respectivamente 
más cerca o más lejos que 10 parsecs de nosotros – estamos graficando magnitudes 
aparentes (V) en el eje de las ordenadas, mientras que las magnitudes 
correspondientes a la ZAMS son magnitudes absolutas, o sea la magnitud que tales 
estrellas tendrían si estuvieran a la distancia estándar de exactamente 10 parsecs de 
nosotros; (2) las estrellas del cúmulo también podrían aparecer ligeramente más rojas, 
esto es, con índices de color B-V un poco más elevados que los de la ZAMS por 
causa del polvo interestelar, el que absorbe más luz azul que luz roja. Sin embargo, la 
forma de la curva de la ZAMS debería ser bastante similar a la de la parte más baja de 
la secuencia principal del cúmulo. Tú puedes “ajustar” la curva de la ZAMS a la de la 
secuencia principal del cúmulo por medio de los dos botones de deslizamiento que 
aparecen a la derecha y abajo en la ventana Color-Magnitude. El botón de 
deslizamiento de la derecha permite ajustar exclusivamente el factor distancia, 
mientras que el de abajo permite ajustar exclusivamente el factor enrojecimiento. 

 
• Para esta parte del ejercicio, el botón de deslizamiento correspondiente al 

enrojecimiento ha sido preajustado a un valor aceptable para el cúmulo en cuestión y 
no podrá modificarse.  Todo lo que tienes que hacer para encontrar el módulo de 
distancia del cúmulo es mover el botón hasta que obtengas la mejor coincidencia 
posible con la curva de la ZAMS (la parte alta del diagrama HR del cúmulo puede 
estar más afectada por la edad del mismo, mientras que generalmente la parte baja 



HR Diagrams of Open Clusters (Español) 11

presenta más dispersión por efectos observacionales, por lo que lo mejor es ajustar al 
medio de la ZAMS). 

 
 

 
Figure 10 

 
• Cuando hayas obtenido el mejor ajuste posible, el correspondiente valor de 

enrojecimiento, llamado E(B-V), puede ser leído en el display digital de color verde 
que aparece abajo al medio en la ventana Color-Magnitude (0,13 para el caso 
mostrado más arriba), mientras que el correspondiente valor del módulo de distancia, 
V-Mv, puede ser leído en el display digital de color verde que aparece abajo a la 
derecha (+6,15 para el mismo caso mostrado más arriba). Ambos valores pueden ser 
impresos en caso de ir a la barra del menú y seleccionar primero la opción Tools > 
View/Print Parameters, y luego de ser mostrados en una pantalla, seleccionar a 
continuación la opción List > Print. 

 
• Cuanto más alejado esté un cúmulo estelar, mayor es su módulo de distancia, m-M. 

Puedes usar el módulo de distancia para calcular la correspondiente distancia D al 
cúmulo, expresada en parsecs, mediante la aplicación de la siguiente fórmula: 

           
       Log D = ((módulo de distancia)/5) +1 

 
Determinación de la edad de un cúmulo mediante el ajuste de curvas isócronas a su 
diagrama HR 
 

Par un determinado cúmulo, tanto la forma que toma la curva de la secuencia 
principal como la de la rama de las estrellas gigantes van variando con su edad. Es 
por ello que la ZAMS que acabas de ajustar para el cúmulo que elegiste muy 
probablemente no habrá de coincidir  con cada estrella del cúmulo. A medida que un 
cúmulo envejece, las estrellas más azules y de mayor masa de su secuencia principal 
original (ésas que se corresponderían con las estrellas de la ZAMS arriba a la 
izquierda) son las que queman más rápido el hidrógeno en sus núcleos, por lo que son 
también las primeras en volverse gigantes rojas y “salirse” de la secuencia principal. 
Este proceso evolutivo continuará con estrellas ubicadas cada vez más y más abajo en 
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la secuencia principal, por lo que obviamente la secuencia principal se va acortando a 
medida que el tiempo pasa. Los astrónomos pueden usar computadoras para calcular 
cómo una determinada estrella va cambiando su luminosidad y color con el tiempo, y 
utilizar tales cómputos para calcular cómo sería el diagrama HR de un cúmulo para 
una determinada edad. La forma teórica del diagrama HR de un cúmulo para una 
edad en particular se denomina una isócrona (iso = igual, cronos = tiempo o edad), 
lo que representa una curva que muestra la distribución de luminosidad versus color 
para un cúmulo con estrellas de masas diferentes pero todas de la misma edad. Si tú 
puedes encontrar la isócrona teórica que mejor se ajuste al diagrama HR de tu 
cúmulo, entonces sabrás la edad de las estrellas que lo conforman. 
 
 

 
 

Figura 11: Ajustando una isócrona al diagrama HR de un cúmulo 

 

 
• El programa VIREO tiene almacenado un amplio rango de isócronas que tú 

puedes usar para ser apareadas contra el diagrama HR de tu cúmulo. Una vez 
ajustada la ZAMS, puedes luego utilizar la herramienta de ajuste de isócronas. En 
la barra del menú del diagrama Color-Magnitude,  cliquea Tools > Isochrones, y 
verás una isócrona dibujada en tu diagrama HR cerca de donde aparecen 
graficadas las estrellas del cúmulo. Una pequeña ventana que permite definir los 
parámetros isócronos se abrirá al costado, con dos botones de deslizamiento – uno 
llamado Age, y el otro Adjust (B-V) – más una opción de valores predeterminados 
denominada Metallicity. 

 
• Variando la posición de los botones de deslizamiento Age y Adjust (B-V) tú 

deberías poder obtener un satisfactorio apareamiento entre las curvas de secuencia 
principal y de la rama de las gigantes para tu cúmulo en cuestión. El elemento 
clave a tener en cuenta para el ajuste es el “borde” azul (el de más a la izquierda) 
de la secuencia principal, dado que ahí están las estrellas que primero abandonan 
la secuencia principal a medida que el cúmulo envejece. Este “punto de quiebre” 
(turnoff) sobre la secuencia principal es una consecuencia directa de la edad del 
cúmulo. Puede ser que tú no veas muchas estrellas en la rama de las gigantes: ello 
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obedece a que las estrellas en la rama de las gigantes permanecen allí períodos 
relativamente cortos de tiempo (alrededor de solo el 10% del tiempo de vida que 
antes les llevó salir de la secuencia principal) y por tanto pueden haber ya 
desaparecido, habiéndose transformado en enanas blancas, estrellas de neutrones, 
o agujeros negros. También es posible que las estrellas en la secuencia principal 
de tu diagrama HR estén un poco más esparcidas que la fina línea isócrona: en 
parte esto es intrínseco al cúmulo – la secuencia principal aparece siempre 
“gruesa” debido a que, por ejemplo, tanto las estrellas binarias son más brillantes 
que las correspondientes estrellas individuales, como a que no todas las estrellas 
están realmente a la misma distancia exacta de nosotros – pero también puede ser 
que haya algunas estrellas incluidas que en verdad no pertenezcan al cúmulo. Para 
superar varios de estos problemáticos puntos, lo mejor es ajustar tu isócrona de 
forma tal que ella coincida lo mejor posible con las estrellas que aparecen del lado 
más bajo de la secuencia principal. 

 

 
Figure 12 

 
 
• El concepto de metalicidad, vinculado a la composición química de las estrellas en un 

cúmulo, refiere en particular a la relativa abundancia de elementos más pesados que 
el hidrógeno. Los astrónomos genéricamente denominan “metal” a cualquier 
elemento químico más pesado que el helio (lo cual es un término desafortunado, dado 
que también se incluyen no metales, como por ejemplo el carbón, y además gases, 
como por ejemplo el nitrógeno o el oxígeno). Las generaciones más tempranas de 
estrellas en el universo carecían prácticamente de elementos más pesados que el 
hidrógeno y el helio. Sin embargo, las siguientes generaciones sí los tenían, dado que 
las estrellas efectivamente van produciendo elementos más pesados que el hidrógeno. 
Diferencias de metalicidad afectan la evolución de las estrellas, por lo que aparecen 
pequeñas diferencias en las isócronas de un cúmulo en función de su metalicidad. El 
valor predeterminado del programa VIREO para el ajuste de curvas isócronas es el 
que corresponde a la metalicidad solar para los valores de Y (referido a la abundancia 
relativa de helio) y de Z (el que refiere a la abundancia relativa de todos los demás 
elementos más pesados que el helio). Tú podrías probar otros valores de metalicidad 
simplemente eligiendo diferentes valores en el panel metallicity de la ventana 
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Isochrone Parameters. Utiliza las flechas verticales del cursor para variar la 
metalicidad, lo que a su vez cambia la forma de las isócronas, y así tratar de encontrar 
el mejor ajuste posible. 
 

FOTOMETRIA DE CUMULOS USANDO LOS TELESCOPIOS DE VIREO 
 

El programa VIREO ofrece acceso simulado a telescopios ópticos, por los que se 
puede tanto observar las estrellas de un cúmulo, como obtener sus valores espectrales y 
fotométricos. En esta sección describiremos cómo acceder a un determinado telescopio, 
cómo hacer un listado de estrellas del cúmulo, y cómo usar VIREO para obtener valores 
espectrales y fotométricos de las estrellas elegidas. Estos valores podrán luego ser 
procesados utilizando las herramientas de análisis del diagrama Color-Magnitude 
descriptas en la sección anterior. 

 
Obtención de un listado de las estrellas del cúmulo a observar 

 
Los astrónomos suelen hacer una lista de las estrellas que van a observar con 

anterioridad al inicio de la sesión de observación. En particular, cuando se trata de 
cúmulos estelares, es muy importante haber efectuado una cuidadosa selección previa 
dado que no todas las estrellas que aparecerán en las inmediaciones serán necesariamente 
miembros del cúmulo (en la misma región del cielo podrían aparecer determinadas 
estrellas que no tengan nada que ver con el cúmulo, algunas que en verdad estén bastante 
más cerca o mucho más lejos). Para determinados cúmulos estelares de la Vía Láctea, 
VIREO tiene listas donde aparecen varias de sus estrellas integrantes más interesantes, y 
tú puedes usar tales listas para hacer una tabla de sus coordenadas (ascensión recta y 
declinación) de forma tal de facilitar su rápida ubicación cuando les apuntes con el 
telescopio. (Advertencia: La mayoría de tales estrellas son efectivamente miembros del 
cúmulo, pero puede ser que no todas y por tanto algunas más cercanas o más lejanas 
también podrían haberse intrometido). 

 
Para crear el listado del caso, arranca el programa VIREO y loguéate. Desde la 

opción del menú File > Run exercise, elige HR Diagrams of Star Clusters. Cuando 
aparezca el panel de control de VIREO, selecciona File > Cluster Data en la barra del 
menú. Se abre a continuación la ventana Cluster Data Parameters: cliquea entonces el 
botón izquierdo del mouse sobre File abajo a la izquierda, elige View/Select Cluster from 
list, y mira la pantalla Clusters for Study. 
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Cliquea el botón izquierdo sobre el cúmulo que quieras analizar, y su nombre 
aparecerá en la ventana Cluster Data Parameters. Luego cliquea OK y verás aparecer 
una lista de las estrellas del cúmulo, con sus respectivas coordenadas. 

 

 
 

 
Figura 14 

 
Figura13  

Para hacer y guardar el listado de tales posiciones, desde la barra del menú de la 
ventana CLEA Cluster Data elige Selection > Create New Hot List of Entire List (mira 
la Figura 14). Estás ahora pronto para ir a observar, por lo que corresponde que cierres la 
ventana CLEA Cluster Data y procedas a escoger un telescopio óptico. 

 
Acceso a un telescopio óptico de VIREO 
 

Desde el panel de control de VIREO, elige Telescopes > Optical > Access 0.4 
meter. (Nota: Se pueden acceder telescopios incluso más grandes, pero para ello deberías 
haber tramitado el correspondiente pedido formal y en todo caso recibirías un tiempo 
limitado de uso, de acuerdo con cómo tu instructor haya seteado el programa VIREO). La 
pantalla cambiará para mostrarte el interior de la cúpula del observatorio. Abre la cúpula 
operando el interruptor OPEN/CLOSE y cuando la cúpula quede abierta, activa el 
Telescope Control Panel. Verás que en el cielo aparecen estrellas, y que tales estrellas se 
ven gradualmente derivar hacia la derecha (hacia el oeste) debido al movimiento aparente 
del cielo originado por la real rotación de la Tierra. Para compensar dicho movimiento 
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aparente del cielo los telescopios disponen de motores de seguimiento (tracking) que los 
hacen desplazarse exactamente igual. Cliquea en el botón de Tracking, y el telescopio 
empezará a seguir a las estrellas, es decir, de ahora en más parecerá que las estrellas no 
derivan. Estás ahora pronto para apuntar el telescopio a las estrellas del cúmulo que 
quieras. 

 
En la barra del menú, elige Slew > Observation Hot List > View/Select From 

List. Cliquea con el botón izquierdo sobre la estrella a la que deseas moverte, y sus 
coordenadas aparecerán en una ventana llamada Enter Sky Coordinates for Slew. Si tú 
cliqueas ahora sobre el botón OK de ésta y de la siguiente pantalla (la que te pregunta si 
estás seguro) entonces el telescopio debería moverse hasta posicionar la estrella deseada 
en el centro de la pantalla del cielo. Puedes utilizar este mismo procedimiento para 
moverte a cualquier estrella del cúmulo. 

 

 
Figure 15 

 
 
Pudiese ser que no veas inmediatamente la estrella elegida en caso de que ella 

fuese demasiado ténue como para aparecer en el amplio campo del buscador del 
telescopio (finder). Un círculo rojo en el centro de la pantalla del cielo te muestra el 
limitado campo del telescopio. Para poder ver una vista ampliada de este campo, desplaza 
el cursor View en el lado derecho del panel de control de la posición Finder a la posición 
Telescope. Dado que estarás usando el fotómetro para medir el brillo de las estrellas, 
deberías también desplazar el cursor Instrument hacia la posición Photometer. Debes 
ahora poder ver la estrella que deseas observar en el centro de la pantalla del cielo, 
rodeada de un pequeño círculo rojo que representa la apertura admisible de luz que entra 
al fotómetro. 

 



HR Diagrams of Open Clusters (Español) 17

 

 
Figure 16 

 
 

Uso del fotómetro de VIREO para medir magnitudes estelares 
 
Para abrir el panel de control del fotómetro de VIREO, cliquea sobre el botón Access que 
aparece abajo en el sector Instrument. Un fotómetro de apertura como el que aquí usarás 
permite el ingreso de luz a través de un pequeño agujero, la hace pasar a continuación por 
un filtro, y cuenta luego los fotones que arriban a un detector fotosensible. Un primer 
cursor te permite seleccionar el filtro a aplicar de entre los filtros fotométricos estándares 
en astronomía U, B y V; un segundo cursor te permite elegir el tiempo de cada 
exposición (integration time); y un tercer cursor te permite setear el número de 
integraciones (# of integrations) que el fotómetro habrá de capturar y promediar para 
luego determinar el valor medio resultante y la correspondiente magnitud de la estrella. 

 

 
Figura 17  

 
Antes de medir la magnitud de una estrella necesitas determinar la magnitud del 

fondo del cielo, dado que al fotómetro de apertura no solo ingresa la luz de la estrella 
observada sino también luz del cielo. Usa los botones N, E, S, W del panel Telescope 
Control  para desplazar la estrella fuera de la apertura del fotómetro. En el panel 
Photometer Control, posiciona el cursor Reading sobre Sky, el cursor Filter sobre V, el 
cursor Integration Seconds sobre 10, y el cursor # of Integrations sobre 3 (ver Figura 
17). Luego cliquea Start y entonces automáticamente el fotómetro habrá de contar 
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durante 3 períodos de 10 segundos cada uno cuál es el valor medio del fondo del cielo, 
expresado en cantidad contada por segundo. Has también la misma medición pero 
empleando los filtros B y U. Normalmente el valor del fondo del cielo necesita ser 
medido una sola vez por filtro mientras mides la magnitud de las estrellas de un mismo 
cúmulo, especialmente si se lo hace durante un breve intervalo de tiempo (solo si la 
medición se extiende por un período importante de tiempo, en el cual las condiciones del 
fondo del cielo varían, entonces vale la pena volver a medir el valor del fondo del cielo 
para cada filtro).  

 
Una vez hallado el valor del fondo del cielo, mueve la estrella cuya magnitud 

deseas medir con los botones del Telescope Controls  hasta hacerla posicionar en el 
centro de la apertura del fotómetro. Selecciona un filtro, un tiempo de integración, y un 
número de integraciones. El tiempo total de integración óptimo dependerá del mayor o 
menor brillo de la estrella elegida, como asimismo del tamaño del telescopio que estás 
usando. Cliqueando sobre el botón Start  la secuencia de medición habrá de empezar 
automáticamente, y la cantidad contada y la magnitud de la estrella serán luego mostradas 
en el display del panel del Photometer Control. Lo ideal sería que para una estrella 
obtengas una cantidad total contada de 10.000 (o una relación señal/ruido de 100) para 
así poder alcanzar una precisión del 1%, pero si la estrella en cuestión es débil y/o estás 

 
usando el telescopio de 0,4 m, tal precisión puede no ser posible. Haz lo que mejor 
puedas (como alternativa podrías volver para atrás, al panel de control de VIREO, y 
acceder a un telescopio más grande, que obviamente recogerá más luz en menos tiempo). 
Haz un listado de tus mediciones obtenidas para cada filtro U, B y V para la estrella 
considerada, y utiliza las opciones de menú File > Data > Record/Review para almacenar 
dichos valores (el propio programa te guiará para que salves tus datos, si es que antes no 
lo has hecho, cuando intentes cambiar de filtro). 

 
 

 
Figura 18 

 
 
Puedes proceder ahora a medir las magnitudes de otras estrellas del cúmulo. Para 

moverte a otra estrella del listado solo necesitas usar el control del Slew. Si ya has 
obtenido mediciones del fondo del cielo no necesitas volver a hacerlo, por lo que puedes 
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continuar tomando lecturas de nuevas estrellas a través de los filtros B, U y V. Antes de 
comenzar una medición asegúrate de que hay efectivamente una estrella dentro de la 
apertura del fotómetro (pudiera ser que en algunos casos las posiciones de las estrellas 
tuviesen algún pequeño error, por lo que entonces no aparecerían exactamente en el 
centro de la apertura como debiera ser). 
 
Análisis del diagrama HR de las estrellas estudiadas 
 

Una vez que hayas obtenido las magnitudes de todas las estrellas del cúmulo que 
te interesan, simplemente vuelves al VIREO control window (en la pantalla que tiene por 
título VIREO - The Virtual Educational Observatory) para seleccionar Tools > HR 
Diagram Analysis. En la ventana Color-Magnitude Diagram que a continuación se abre, 
elige File > Load/Plot > Data From Observations, y entonces verás aparecer el diagrama 
HR que corresponde a las estrellas para las cuales obtuviste sus colores y magnitudes. 
Puedes ahora proceder a determinar la distancia al cúmulo, como asimismo su 
enrojecimiento y edad, a partir del análisis de su diagrama HR, tal y como fue descrito en 
las correspondientes secciones anteriores. 
 
 
 
Comentario para los instructores: Uso de la cámara CCD del VIREO como alternativa 
fotométrica para determinar magnitudes estelares 
 

Además del uso directo del fotómetro para obtener las magnitudes y colores de las 
estrellas, el programa VIREO ofrece también la posibilidad de hacerlo mediante la 
utilización de la cámara CCD, a la que se accede desde la ventana VIREO Telescope 
Control. La cámara puede operar con uno de cuatro filtros fotométricos posibles (B, V, R, 
I), o con ninguno. Para utilizar esta opción la computadora con la que se está trabajando 
debe estar conectada a Internet, dado que VIREO toma información de observaciones 
CCD pertenecientes a catálogos estelares que están en red (NOMAD y USNO-B1). 

 
Sin embargo, éste sería un ejercicio para estudiantes más avanzados, dado que es 

necesario evaluar el tiempo de exposición que optimice la relación señal-ruido de forma 
tal de no saturar las imágenes. Las imágenes CCD, en formato FITS, pueden ser 
mostradas usando cualquier software astronómico estándar, y ser medidas y analizadas 
usando cualquier software fotométrico y astrométrico. El programa VIREO actualmente 
ofrece un software astrométrico (el CLEA’s TOOLKIT FOR ASTROMETRY), el que para 
estrellas individuales ejecuta astrometría de gran precisión y también fotometría de baja 
precisión. VIREO también ofrece acceso al software de uso libre para imágenes DS-9. En 
cambio, VIREO todavía no tiene incorporado un software de fotometría a partir de 
imágenes CCD, pero existen varios, tanto de uso comercial como libre (IRAF) que 
aceptarán sin problema las imágenes FITS creadas por VIREO, dando como resultado las 
magnitudes “instrumentales” del caso. Si se conociese la magnitud “estándar” de una 
estrella de referencia ubicada en la misma imagen, las magnitudes instrumentales de las 
estrellas del cúmulo podrán ser entonces convertidas en magnitudes estándares. 
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DIAGRAMAS HR DE CÚMULOS ABIERTOS 

Guía de trabajos para estudiantes aplicando el programa VIREO 
 
 

El Observatorio Virtual Educacional (VIREO) contiene valores fotométricos para 
varios cúmulos estelares de la Vía Láctea. Puedes acceder a dichos valores y usarlos para 
observar y analizar los diagramas HR correspondientes a cada cúmulo, con lo que 
también podrás determinar sus respectivas características. 

 
Imagina que estás haciendo una investigación acerca de los cúmulos estelares de 

la Vía Láctea cuyo listado figura más adelante. Usando las posibilidades que te ofrece el 
programa VIREO, antes descriptas en este manual, tú puedes llevar adelante dicha 
investigación. Perfectamente podrás determinar cuáles son las propiedades que 
caracterizan a tales cúmulos, y por tanto elaborar algunas conclusiones acerca de la 
evolución de las estrellas en nuestra galaxia. 
 
Para ello, procede de la siguiente manera: 
 

1) Repasa los procedimientos del programa VIREO que permiten tanto acceder a los 
datos almacenados de cúmulos estelares, como también mostrar y analizar 
distintos diagramas HR. 

2) Arranca el programa VIREO y ejecuta el ejercicio HR Diagrams of Clusters. 
3) Para cada cúmulo que aparece en la tabla Una Investigación acerca de cúmulos 

estelares de la Vía Láctea de la página que sigue, obtiene la información 
necesaria que ofrece VIREO, analiza su correspondiente diagrama HR, y 
completa los espacios en blanco de la tabla. 

a) A medida que vas analizando cada cúmulo, quizás desees imprimir el 
correspondiente diagrama HR para incluirlo en tu informe. Para ello, es 
bueno saber que cada pantalla de VIREO ofrece la posibilidad de 
imprimir, generalmente entrando desde el menú File. 

b) Tu instructor también quizás quisiera dar una mirada a cada cúmulo en 
cuestión. Tú puedes hacer un listado de las estrellas de cada cúmulo, 
acceder al telescopio óptico de VIREO, y desplazarlo hacia una cualquiera 
de las estrellas elegidas para así observar un cúmulo en particular. Los 
telescopios ópticos también están equipados con cámaras CCD, de forma 
tal que puedes tomar una foto del cúmulo y guardarla en un archivo de 
imágenes o imprimirla para ser incluida en tu informe.   

4) ¿Cuál de los cúmulos es el más viejo? ¿Cuántos años tiene? 
5) ¿Cuál de los cúmulos es el más joven? ¿Cuántos años tiene? 
6) ¿Qué relación hay entre los años de dichos cúmulos con la edad de nuestra 

galaxia? ¿O con la edad del universo? Comenta acerca de cualquier posible 
diferencia. 

7) ¿Cuál es el cúmulo más distante, y cuál es el más cercano? Comenta acerca de 
qué nos dicen tales distancias en relación a las dimensiones de la Vía Láctea? 
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El formato de tu informe 
 
Tu instructor te indicará el formato que tu informe deberá tener. Entre las distintas 
posibilidades están: 

• Simplemente completar la tabla de la página siguiente, y contestar las 
preguntas en una hoja separada. 

• Escribir un breve informe tipo “práctica de laboratorio”, describiendo tus 
observaciones, análisis y resultados. 

• Redactar un informe formal tipo “artículo periodístico”. 
 

 
 
 

TABLA DE VALORES PARA EL EJERCICIO DEL DIAGRAMA HR 
 

UNA INVESTIGACION ACERCA DE CÚMULOS ESTELARES DE LA VÍA LÁCTEA 

Nombre del 
cúmulo 

Ascension 
Recta (RA) 

Declinaci
ón (DEC) 

Módulo de 
distancia 
(m-M) 

Distancia 
(parsecs) 

Enrojecimient 
(E(B-V)) 

Edad 
(años) 

Comentarios 

NGC 752        
 
 

Mel 20 
(Alpha Per) 

       
 
 

The Pleiades 
(M45) 

       
 
 

The Hyades        
 
 

Praesepe 
(M44) 

       
 
 

M67        
 
 

IC 4665        
 
 

 


	DIAGRAMAS HR
	DE CUMULOS ESTELARES
	El formato de tu informe


